Technology Assignment: Graph Formula

The goal of this technology assignment is to graph a formula on your calculator and in Excel. This

assignment assumes that you have a TI-84 or similar calculator and are using Excel 2007. The formula

you will graph is

y=ax+b

where a is the number of letters in your first name and b is the number of letters in your last name. For

instance, if you had one letter in both your first name and last name, you would be working with the

formula

y=1x+1

This is the formula that will be used for demonstration purposes. You will use the formula for your name

with minor modifications to the steps below.

Graph the Formula on a TI-84

1. Pressthe key to turn your calculator on.

Flakl Flakz Flakz

~MiR1#R+1
2. To enter the formula into the calculator, press the key. :3 : —
) . _ wWy=
3. Inthe first line after \'Y1=, type the formula. For the wMe=
formula pictured to the right, type [1][X](X.T.0.0)[+][{]. You'll ~Me=
need to change the numbers for your formula. wN =
4. Now we'll adjust the viewing window on the calculator.
Press to see the current window.
5. You'll see a screen like the one to the right. This window
defines the left, right, upper and lower boundaries of the WIHOOL
graphing window. Since Xmin is -10, Xmax is 10 and Xsc Amin=-1H
is 1, the horizontal extent of the window will be from -10 to Amax=18
- . o . Ascl=1
10 with tick marks on the x-axis every 1 unit. Since Ymin is - Umin=-1@
10, Ymax is 10 and Ysc1 is 1, the vertical extent of the Ymaw==10H
window will be from -10 to 10 with tick marks on the y-axis Yacl=1
ares=11

every 1 unit.

6. Adjust the window to extend horizontally from 0 to 10 in
increments of 1. Extend the vertical extent of your window
so that you can see all of your graph.
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7. Press to see the graph of the formula. Make sure
that you have adjusted Ymax and Ym1i n so that you r graph
enters on the left and right sides of the graph like the one
shown to the right. If your graph enters on the top or
bottom of the window, go back to step 4 and adjust the
vertical extent of the window.

8. Once you have an appropriate graph, press (WINDOW] and
make a note of the settings. You'll want to use the same
settings for the graph you make in Excel.

Graph the Formula in Excel 2007

1. Start Excel 2007.

2. You should see a screen like the one below once Excel 2007 has started.
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Excel has many capabilities that allow it to do calculations and make different types of graphs.
Along the top of the window are the tabs. As shown, the Home tab is selected. This tab contains
many formatting options as well as the copy and paste buttons. Other tabs can be selected such
as Insert, Page Layout, ect. Other tabs will appear as needed as you work in Excel.

The main part of Excel are the cells. The cells form a large table. For instance, the black box is
currently in cell A1 meaning that it is in the column labeled A and the row labeled 1. You can
click your mouse in other cells and see the location of the cell change in the label just above the
cells.

Above the cells is the formula bar. This is where you will enter formulas you want Excel to
calculate.
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In cell A1 type 0 and in cell A2 type
0.5.

Click your mouse in cell Al. While
holding the left mouse button down,
drag your mouse to cell A2. You
should see a black box around cells
Al and A2 like the one to the right.

In the lower right hand corner of this
black box is the fill handle. This
handle allows you to fill cells with
numbers without having to enter the
numbers individually.

L I < T T T, (O S R T 5 Y P

10

LR

fill
handle

10.

Place your mouse over the fill
handle. The cursor should change to
a black cross.

Hold the left mouse button down
and drag the cursor down. The box
will expand as you drag the mouse
like shown to the right. As you drag,
numbers will appear like the 2.5
shown indicating what numbers will
be placed into the corresponding
cell. Since the pattern established by
the first two numbers indicates that
the numbers should increase by 0.5
in each cell, the cells will contain 0,
0.5,1,1.5, ..

[ T T R T O O T ) 5 Y 2

10
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11. Drag the mouse to cell A11. This will Al v
fill the cells A1 through A11 with the ' A B
numbers 0, 0.5, 1, 1.5, ..., 5. These 1 0
numbers will be the x-values in the 2 0.5
graph we will create. 3 1

4 1.5
5 2
6 2.5
7 3
8 3.5
9 4
10 4.5
11 3
12 =

12. Now we’ll type in the formula. In cell
B1, type = 1*Al1+1. You can click on
cell Al instead of typing Al if you
want. It is very important to start - X v f | —1FA1+]
with an = so that Excel knows you
want it to do a calculation. It is also 8 B B
. . oj=1*A1+1 |
important to type the * for A
multiplication. Make sure you
modify the values to reflect the
formula you are graphing.

13. Press Enter on the keyboard. This | B2 h
will cause Excel to take the value in A B
cell A1 and multiply by 1 and then 1 0 1
add 1. In this case we get 1. You may 2 I:"-5| _I

3 1

get a different number depending on
your formula.
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14. Click your mouse in cell B1 again. . Bl |
A B
15. Grab the fill handle and drag it to cell 1 i 1 i
B11. 2 0.5
3 1
4 1.5
5 2
i] 2.5
7 3
a8 3.5
9 a
10 4.5
11 5 14
12
16. Release the mouse button. The cells | Bl -
will be filled with y-values from your A B
formula where the x-values come 1 0 1
from the corresponding cells in the A 2 0.5 1.5
column. This is the table we will use 3 1 2
to create the graph of the formula. 4 1.5 2.5
5 2 3
6 2.5 3.5
7 3 4
8 3.5 4.5
9 4 5
10 4.5 5.5
11 5 6

=
fsd
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17. Click in cell A1 and hold down the Al -
left mouse button. A B
18. D h l1B11 I : 0 =
. hrag t”e.cursor to cle to select 2 0.5 L5
the cells in your table. 3 1 5
4 1.5 2.5
5 2 3
] 2.5 3.5
7 3 4
8 3.5 4.5
9 4 5
10 4.5 5.5
11 5 o
12 %_ 5]
19. CIICk your mouse on the Insert tab Insert Page Layout Formulas Data Review WView
(8] clip Art i Line ~ b Area -
20. Under the Charts panel, select LEIE Ly shapes - C&!ﬂ @B Fie - [ Scatter g
Scatter ?JSmartn.rt - §-Bar' Scatter
' Illustrations Charl ‘ 5
v £l o R £
21. From the different types of graphs, = |D = =
select Scatter with Smooth Lies as 1 L
shown. Other options allow you to 1‘2 o] o
create other types of graphs. 2.5 e d
3 |
3.5 iﬂ] All Chart Types...

22. Your graph will appear. This is a very basic graph. The horizontal window is based on the
numbers you entered in column A. Excel creates a vertical window based on the values in
column B. We'll now customize the graph to make it look nice.
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4
| o3 / =——Seriesl

23. Notice that when you click outside of
the graph, the tabs along the top of Chart Toots

the window change. To customize : =
it Design Layout Format el

tabs allow you modify the look and —hart Styles

the graph, we need to make sure
that the graph is selected (click the -
mouse on it). You'll see a set of tabs

like those shown to the right. These

features on your graph.

24. To begin, let’s eliminate the legend “Series 1” on this graph. Click on the legend so that it is
highlighted and press the Delete key on your keyboard. The legend should disappear.

25. Click on one of the horizontal gridlines so that they are highlighted. Press Delete on the
keyboard to get rid of them. Your cleaned up graph should look like the one below. This graph is
very similar to the one you obtained on your calculator, except the axes are labeled.
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0 1 2 3 4 5 5]
26. The last modification we’ll make to . . . T
this graph is to change the viewing _3 ! 8 B
Delete

window. Right click on one of the cx |
&4 | Resetto Match Style

numbers in the horizontal axis scale.
. . Font...
A menu like the one to the right

I'Ih Change Chart Type...

should appear. If it does not, try
53 Select Data...

right clicking again.

Add Major Gridlines
Add Minor Gridlines
éf' Eormat Axis...
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27. Select the Format Axis... option. The | FEEI 1 i

box on the right will appear. In this
technology assignment we are

Axis Optians | Axis Options i

Murber Minimum: (& Augte ( Fixed I.j,.j

interested in the Axis Options. Using Fil Maximum: (% Auta ( Fixed [5.0
Axis Options, you can change the Line Calor Major unit: @& auge ' Fixed [1.0
change the left and right limits of Line Style Minor unit: & Autg ' Fixed [0.2
your window as well as how often a Shadow I Values in reverse order

. . . [ Logarithmic scale 10
tick mark is made on the horizontal 3-D Format

. Al t Display units: INone vl

axis. Ignmen I_

Major tick mark type: | Qutside -

Minor tick mark type: | Mone

i

Axis labels: Mext to Axis  w

Vertical axis crosses:
@ Automatic

] € Axis value: IIJ.EI

' Maximum axis value

Close |
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28. Under Axis Option, click on Fixed Format axis 21X
next to M|n|r.num. You can sele.ct a.ny | s optons | | pic Options
value to put into the box. Keeping it S pumber MmO e © feed fo ]
at 0.0 means that Xmin for the graph Fil Maximum: 0 ayto ) Fixed |5
will stay fixed at 0.0. Click on Fixed Lire Color Major unit: ¢ pute ) Fixed |1.|:|
next to Maximum. You can select Line Style Minor unit: (" autp ¥ Fixed [0.5
any value to put into the box. Shadow [ Velues in reverse order
. ™ Logarithmic scale 10
Change it at 5 means that Xmax for 3-D Format
. i t Display units: INnnE vI
the graph will stay change to 5. Alignme r
Making these changes will insure Magor tick mark type: Im
that the graph is in a horizontal o
Minor tick mark type: M
window from 0 to 5. )
Axis labels: INexttc- Axis vl
29. Now change the Major and Minor Vertical axis crosses:
. . ) ¢ Automatic
units as shown. The Major units are ] C msvae I
where the scale numbers appear. | ' Maximum axis value

Setting the Major unit to 1.0 means
that a number will appear on the
horizontal scale at every one unit.

Minor units are simply tick marks on

the axis without numbers. Setting

the Minor unit to 0.5 means that a

tick mark will appear every 0.5 units.
Make sure you select Outside for the
Minor tick mark type to insure they
appear in your graph.

30. Select Close to see the changes in
the graph.

31. Your graph will be changed as seen below.
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Notice the scaling at every 1 unit and the tick mark at every 0.5 units on the horizontal axis.

32. Right mouse click on one of the numbers | FRcl 2lx

on along the vertical axis. —— . .
g 2 | s Options | Axis Options
. i | Number Minimum: 0 aute @ Fixed [0.0
33. Select Format Axis... ] . ]
Fill Maximum: ¢ pyteg % Fixed IID—
Line Color Major unit: puto % Fixed IZ

34. Adjust the numbers to reflect those on

H i Minor unit: ¢~ aute (% Fi ed |1
the r|ght. Line Style uto ixe I

Shadow [T values in reverse order

30 Format [ Logarithmic scale 10

Alignment Display units: INonE - I
-

Major tick mark type: I Cutside - l
Minor tick mark type: M
Axis labels: INext to Axis | ¥ l

Haorizontal axis crosses:
O Automatic

0 Axis value: I-ZI.EI

' Maximum axis value

Close

35. Your graph should now look similar to the one below.
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10 4

36. To finish this tech assignment, you need _@/ p—
to copy your graph from Excel to word N
processing document in Word (or a 3 ‘*‘ Calik
similar program). Click on your graph to Paste “% =
select it. = /

Clipboard

37. On the Home tab, left click on the Copy | P
button to copy the graph to the
clipboard.

38. Open Word (or another word processing

39.

40.

41.

program).

At the top of the document, type your
name, class, and the date followed by a
carriage return (Enter).

In Word, left click on the Home tab.

Select Paste to paste the graph into your
Word document. Your document should
look similar to the one shown to the
right.

Rolandolsolex

MAT152 MW BAM

August10, 2009

10

-3

6

42.

Finally, you need to save this document
to a convenient location. In the upper
left hand corner of Word, left click on
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43.

44,

45.

the disk icon.

Give the document and appropriate
name and location and select Save.

You can also select the Office button to
the left of the disk icon. This is useful to
save the document with a new file
name. In this case you would select Save
As... and then give an appropriate name.
If you are working on a document over
several days, it is advisable to save the
document with a slightly different name
on each day based on the date. This
allows you to recover earlier version of a
document in case you need to refer to
earlier work.

In Excel, save you Excel worksheet by
following the steps 42 through 44.

—_ @u: i)
)

Home Insert

e
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